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Introduction

Overview
Sample Builder lets you load gigabytes of your own samples into supported Korg instruments and plug-ins. 
You can import mono or stereo .wav or AIFF files, including metadata for loop points and root keys, at practically any 
sample rate. Sample Builder is not a full-featured audio editor, but it does include basic tools for editing start points and 
loops, as well as non-destructive adjustments for volume and tuning. You can arrange the samples across the keyboard 
to create Multisamples, and group Multisamples into Banks. 
Instruments can have one User Bank loaded at a time, with about 3,000 mono samples (or 1,500 stereo) in up to the 
same number of Multisamples. Multisamples use unique identifiers (UUIDs), so Programs and Wave Sequences keep 
track of them even if they are loaded in a different Bank, or if the Bank order or name changes.
The User Bank does not replace any other samples on the instrument; factory sounds and samples will remain intact.

Two modes: Multisample and Bank
The buttons in the upper right of the main window select whether you’re working with the Multisample editor or the 
Bank editor. For the most part, you can simply switch between the two without thinking about it. It’s important to note, 
however, that some menu commands may be available only in one mode, and that undo is handled separately for each 
mode.

Menu commands
In general, menu commands for Multisample editing operations and Sample import are available only when the 
Multisample window is active. Similarly, menu commands for saving Banks are available only when the Bank window 
is active.

Undo/Redo
Sample Builder supports multiple levels of undo and redo for most actions, including importing Samples into 
a Multisample, editing Samples and Multisamples, editing Banks, and so on. For instance, you could import a 
keyboard-full of .wav or AIFF files into a Multisample, switch to the Bank window and remove a group of twenty other 
Multisamples, and finally go back to the Multisample window and edit a Key Zone–and safely undo all three actions in 
turn. Note that Send Bank and Remove Bank From Device are not undoable.
Undo/redo history is maintained separately for the Multisample and Bank modes. You’ll see this in the menu 
commands, whose names change based on the mode to either Multisample Undo/Redo or Bank Undo/Redo, 
respectively.

Operating requirements
To use Sample Builder, you need the following:
• a supported instrument or plug-in, including any model of wavestate (version 2.0 or later), modwave (version 1.1 

or later), wavestate native, or modwave native
• a USB cable (for hardware instruments)
• a USB-capable Mac or Windows computer that satisfies the requirements below.
Note: Full functionality is not necessarily guaranteed with all computers, even if they satisfy these system requirements.

MacOS
Mac OSX 10.12 through macOS 13, Intel or Apple Silicon.

Windows
Windows 10 and 11, 64-bit versions only. Touch panel operation is not supported.
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Using Sample Builder

Preparing your .wav or AIFF samples
Before you import your audio files into Sample Builder, you may want to take a few steps to get them ready to use.
1. Process your samples as desired, and use your desired looping tools.
Sample Builder includes basic tools for setting start points and loops, but it is not intended to be a full-featured audio 
editor. For more sophisticated sample editing, you may wish to use one or more third-party applications first. Sample 
editors can often save loop points in the audio files, and Sample Builder will import these automatically. If you use 
anything other than standard loop methods (for instance, if you create crossfade loops), make sure to render the results 
to the audio file.
Note that Sample Builder supports only .wav and AIFF files, and not other formats (such as mp3). The samples can be 
either stereo or mono, with bit depths from 1 to 32, at practically any sample rate. Samples sent to the instrument will 
retain the original sample rate, but will always be converted to 16-bit data, using dithering when appropriate. Individual 
Samples can be as long as 512 MB, or as short as 8 samples.
2. Prepare your key mapping.
To take advantage of Sample Builder’s automatic keyboard mapping, either check that your sample editing tool saves 
the root key in the audio file metadata, or name the audio files so that the note is reflected in the last four characters 
of the name, using sharps instead of flats (e.g. C4 or C#-2). Only the standard note names A, B, C, D, E, F, and G are 
supported. 
You can select whether Sample Builder pays attention to the audio file metadata, or only to the file name; see “Use file 
name instead of embedded audio file metadata for sample Original Key detection” on page 13.
3. Prepare your folder structure.

Important: Multisamples do not include the audio data of their Samples; instead, they just link to the separate 
.wav or AIFF files on disk. 

When moving or backing up data, make sure to include the .wav or AIFF files as well as the Multisample files! To make 
this easier, plan ahead to store the audio files within the same folder structure as the Multisample. For example:
Synth 1 folder
 Synth 1 Multisample file
 Synth 1 .wav folder
  Synth 1a.wav file
  Synth 1b.wav file 

Working with Multisamples
Once your samples are prepared, you can use them to create Multisamples. To do so:
1. Import the .wav or AIFF samples into Multisamples in Sample Builder.
Select the Multisample window in Sample Builder, and use the File menu’s New Multisample command to create a 
new, empty Multisample. You can then either drag .wav or AIFF files from the file system onto the virtual keyboard, 
or import them via the File menu Import Audio File(s)… command. Multiple samples can be added at once, and if 
you have a set of samples which will be laid out across the keyboard (such as different pitches sampled from the same 
instrument), adding them all at once is the easiest way to take advantage of automatic key mapping. 
When you import one or more samples into an empty Multisample, Sample Builder will set the sample root keys (aka 
“original keys”) using either metadata from the audio file or the file name, as described above. Keyboard zones are also 
set automatically, based on the original keys. Original key and zones can be edited manually after import, as desired.
When you import samples into a Multisample which already has one or more samples, Sample Builder will divide the 
key zones evenly as best it can. You’ll probably need to edit zones manually in this case. 
At any time, you can use the Auto Map Key Zones menu command to re-assign the samples to zones based on the 
metadata or filename, as described for import, above.
Multisamples can have up to 128 Key Zones, one per note. Key Zones cannot overlap.
Alternatively, you can convert a batch of .wav or AIFF files into single-sample Multisamples. To do so, drag the audio 
files directly into the Bank window (not the Multisample window), or use the File menu’s Import Audio Files As 
Multisamples… command.   
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2. Edit the Multisample as desired.
For instance, you might adjust sample tunings or loop tunings, fine-tune start points to get rid of silence at the 
beginning, adjust Key Zone volumes so that the sound plays evenly across the keyboard, assign a Category, edit the 
name, and so on. All of these settings are stored in the Multisample - not the individual .wav or AIFF files.
You can play the Multisample within the Sample Builder from a connected MIDI keyboard, as selected in the 
Preferences dialog’s Audio/MIDI tab.
3. Save the Multisample to a file on disk.

Important: It’s critical to understand how UUIDs relate to Multisamples, and how the Save and Save As… 
commands differ in this regard. For details, see “Multisamples are identified by UUIDs” on page 6.

4. Repeat the above steps to create more Multisamples.

Working with Banks
Once you have some Multisamples, it’s time to put them into a Bank so that you can use them with the instrument or 
plug-in. (Only Banks can be sent to an instrument or used with a plug-in–not individual Multisamples.) To do so:
1. Switch to the Bank window.
2. Add Multisamples to the Bank as desired.
By default, any Multisamples that you’ve saved during the current editing session will be automatically added to the 
current Bank. (See the Preferences setting “When this is enabled, the software checks at startup to see if a new version is 
available. If so, a dialog appears with a download link.” on page 13.) You can also drag Multisample files from the disk 
into the Bank window, or use the File menu to import them.
3. Edit the Bank Name, Author, and Note as desired.
The Bank Name appears as the Collection name on the instrument or plug-in.
4. Save the Bank to a file on disk.

Important: Banks link to Multisample files on disk. Neither the Multisamples nor the .wav or AIFF sample 
data are stored with the Bank. For organizational purposes, it’s easiest to store the Multisample files within the 
same folder structure as the Bank.

Two resources: RAM and Storage
Multisamples use two different resources: RAM and Storage.
Each Key Zone uses a small, fixed amount of RAM, regardless of how long the sample is. This is typically 16 KB for each 
mono sample, and 32 KB for each stereo sample. So, the available RAM limits the number of Key Zones that can be 
loaded at once.
Storage, on the other hand, uses space for the entire length of the Key Zone’s sample, from the Start offset to the End 
offset. This can be from a few kilobytes for a very short sample, up to 512 MB for a very long sample. So, the available 
Storage limits the total length of the samples that can be loaded at once.
Depending on the specific Multisamples being used, you may run into one of these limits before the other. The amount 
of available storage and RAM space may also vary depending on the connected device. For more details, see “RAM 
Size” and “Storage Size” on page 12.

Recovering links to files which have been moved or renamed 
If you load a Bank whose linked Multisample files are moved or renamed, or a Multisample whose linked .wav or AIFF 
files have been moved or renamed, a dialog will appear prompting you to locate the files manually or search within a 
specified folder (and any sub-folders). If the missing files are all in the same folder, and have not been renamed, you’ll 
only need to select the first file; Sample Builder will automatically look in the same folder for the rest of the missing files. 
Make sure to save the edited Bank and/or Multisample after doing this!

Sending a Bank to a hardware instrument
1. Set up the instrument to work with RNDIS or NCM, if you have not done so already.
See the directions in the PDF manuals for the instrument’s Updater or Editor/Librarian.
2. Connect the instrument to the computer via USB.
3. If you have multiple instruments connected, select one you’d like to use from the Devices menu.
4. Load a Bank (or simply use the one that you’ve been working on).
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5. Press the SEND BANK button to send the Bank to the instrument.
Instruments can hold one User Bank at a time. If there is already a Bank on the instrument, it will be removed and 
replaced by the new Bank.
If the Bank is too large to fit, the Bank RAM Size and/or Bank Storage Size will be shown in red, and the SEND BANK 
button will be grayed out. For more information, see “Two resources: RAM and Storage” on page 3.

Using the new Multisamples on a hardware instrument
On the wavestate, for example, you can use Multisamples in two different ways: as Single Multisamples, or in Wave 
Sequence Sample Steps. 

wavestate: Single Multisample
To use a new Multisample as a Single Multisample, to play on its own or to layer with other sounds:
1. Press the WAVE SEQUENCE SELECT button.
2. Set the Mode to Single Multisample.
3. Continue to “Selecting Multisamples,” below.

wavestate: Wave Sequence
To use a new Multisample in a Wave Sequence:
1. Press the WAVE SEQUENCE SELECT button.
2. Set the Mode to Wave Sequence.
3. Press the SAMPLE button, to select the Sample Lane.
4. Press the WAVE SEQ STEPS button, so that buttons 1-16 select Wave Sequence Steps.
5. Press a lit button, to select a Step in the Sample Lane.
You can also add new Steps, and use Step Solo to make it easier to hear a selected Multisample in context; see the 
wavestate Owner’s Manual for details.
6. Continue to “Selecting Multisamples,” below.

Selecting Multisamples
Continued from the above…
1. Select the MS parameter.
2. Press ENTER.
The Multisample selection list will appear.
3. Press button 16, to select the User Category.
All samples from Sample Builder are automatically placed in the User Category.
4. Use the VALUE dial or < and > to browse through the Multisamples in the list.
You can listen to the different Multisamples without closing the list.
5. When you’ve found a Multisample that you like, press ENTER.
That’s it! The new Multisample is now selected.

Saving a Bank for a plug-in instrument
To use a Bank with a plug-in, you’ll first save a self-contained version of the Bank and all of its Multisamples and 
Samples (file extension: .korgcompiledbank), and then select the Bank in the plug-in. To do so:
1. In Sample Builder, load a Bank (or simply use the one that you’ve been working on).
2. Select the Save Bank For Plug-in command from the File Menu.
This brings up a standard file menu.
3. Save the file to disk with a descriptive name.
Since the file contains all of the sample data, it can be quite large - up to 4 GB.

Important: .korgcompiledbank files are only for use to export Sample Builder data to compatible plug-ins. 
Once saved, they cannot be opened or edited by Sample Builder. Make sure to preserve your original Bank, 
Multisample, and .wav or AIFF sample files.
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Using the new Multisamples in a plug-in instrument
Loading a User Sample Bank
1. In the plug-in,  open the Settings dialog and click on the User Sample Bank parameter. 
A standard file dialog appears.
2. Select the .korgcompiledbank file from step 3.
This selection is stored with the DAW session, and applies to all open instances of the plug-in–even if the instances are 
in different hosts. You can have many different User Sample Banks stored on your computer, but only one can be used at 
a time.

Selecting Multisamples
User Multisamples appear in the Multisample Browser, along with all other Multisamples. You can filter the Browser to 
show only your user Multisampless. To do so:
1.  In the plug-in’s Multisample Browser, select the User Category.
The Browser will now show only the Multisamples from the selected User Bank.

Sharing and distributing Multisamples and Performances
You can share sets of Multisamples, Performances, and other sound data (such as wavestate Wave Sequences) with 
other users. To do so:
1. In Sample Builder, prepare all of your data.
Arrange your files so that the .wav or AIFF files, Multisamples, and Bank are all in the same folder structure on disk. 
This ensures that the Multisamples will automatically find their .wav or AIFF files, and the Bank will automatically 
find its Multisamples. The Consolidate Bank Files command will create an organized structure automatically; see 
“Consolidate Bank Files…” on page 15. For more information, see “Preparing your .wav or AIFF samples” on page 
2, and “Recovering links to files which have been moved or renamed” on page 3.
2. In the Finder (MacOS) or File Explorer (Windows), make a .zip file of the entire folder structure containing 

the .wav or AIFF files, Multisamples, and Bank.
3. For hardware instruments, connect the instrument via USB (if it’s not already connected), and run the Editor/

Librarian. For plug-ins, simply go to the Librarian window.
4. Select the All Data tab in the Librarian window.
5. Select all of the sounds that you’d like to share.
You may find it convenient to give all of them the same Collection name. The Librarian lets you edit the Collection 
name for multiple items at once; just select all of the sounds, and then type into the Collection field in the inspector on 
the right.
6. Export the sounds as a Bundle.
This will create a single file on disk, with all of the Performances, Wave Sequences, etc.
Another user can then import the Bundle via the Editor/Librarian (for hardware) or the Librarian window (for plug-
ins), and use Sample Builder to send the Bank to a hardware instrument or save it for a plug-in. They can also merge 
the new Multisamples into their own Bank, as described below. Since the Multisamples are identified by UUIDs (see 
“Multisamples are identified by UUIDs,” below), the Performances, Wave Sequences, and any other sound data will find 
them automatically.

Using Multisamples from two or more different Banks
Performances, Wave Sequences, and other sound data link directly to individual Multisamples, via UUIDs. Banks 
are just a way of grouping those Multisamples; to the Performances, Wave Sequences, etc., the Bank itself really 
doesn’t matter. The wavestate native and modwave native plug-ins can use multiple Banks at once, but the hardware 
instruments can use only a single Bank at a time. To use Multisamples from different Banks on hardware instruments, 
you can just create a new Bank:
1. In Sample Builder, create a new Bank.
2. Drag all of the Multisamples that you’d like to use into the new Bank.
Multiple Banks can have links to the same Multisamples, so you can make as many of these new Banks as you like. It’s 
OK if the Multisamples are in different folder structures. If you move them later, you can always recover the links; see 
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“Recovering links to files which have been moved or renamed” on page 3. To avoid this, however, you can set up a 
master folder for Sample Builder data, such as:
Korg Sample Builder Documents folder
 Bank 1 folder
 Bank 2 folder
  Synth 1 Multisample folder
   Synth Multisample file 
   etc.
3. Save the new Bank.
4. Send the Bank to a hardware instrument, or save it for use with a plug-in.

Multisamples are identified by UUIDs
Multisample files include a “universally unique identifier,” or UUID. You can think of the UUID as the Multisample’s 
true name, or its fingerprint. The names that you give to Multisamples and Banks, such as Orchestral Strings or My 
Sample Bank, are important for you to be able to identify them–but Programs and Wave Sequences only care about the 
UUID.
This means that even if you rename the Multisample (either the name in the metadata, or the name of the file on disk), 
Programs and Wave Sequences will still know how to find it. You can also use the same Multisample in different Banks, 
without worrying about the Bank name or the order of the Multisamples in the Bank.

Save vs. Save As…
A new UUID is assigned to the Multisample when you create a new Multisample, or when you use the File menu 
Save As… command.
The difference between Save and Save As… is important:
• Use Save when you’re editing an existing Multisample, and you want the changes to be reflected everywhere that 

it’s used. This ensures that the UUID stays the same.
• Use Save As… when you want to make a new, different version of a Multisample–one that won’t change previously 

created sounds.

Avoid duplicating Multisample files in the Finder or File Explorer
Don’t duplicate Multisample files in the Finder or File Explorer, unless you’re making a backup.

Important: If you duplicate a Multisample file in the Finder (MacOS) or File Explorer (Windows), the 
duplicate will have the same UUID as the original. To the instrument, this means that they are the same 
Multisample–even if you change the name and all of the contents of the “duplicate” file.

If you edit these duplicated files to create entirely different Multisamples, your Programs and Wave Sequences will end 
up playing the wrong data!

Duplicate UUIDs
When you load a Bank, or add Multisamples to a Bank, Sample Builder will check that there are no duplicate UUIDs. If 
duplicates are detected, you’ll have the option to either skip them, or modify the Multisamples to use a different UUID. 
If you choose to modify the Multisample, the new UUID is stored to the Multisample file on disk. There is no way to 
undo this change. 
If the Multisample’s UUID is changed, this also breaks any existing links to the Multisample from Programs or Wave 
Sequences. They’ll still be looking for the old UUID, and will play silence instead (or another Multisample with the 
same UUID, if one exists). To fix this, you’ll need to manually re-select the Multisample for each individual instance. 
As long as you use Save and Save As… as described above, and don’t duplicate files on disk, you won’t have any 
problems with duplicate UUIDs.
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Multisample window

Level Meter
A stereo meter at the top of the window shows the playback level in real-time (including polyphonic playing). This can 
make it easier to balance Key Zone levels.

Multisample
Name
Names can be up to 24 characters long, so that they fit on the hardware display.

Author
Your name here! You can use the Default Author preference to fill this in automatically; see “Default Author” on page 
14.

Category
[None…Waveform]
Multisamples can have two Categories. When created in Sample Builder, the first Category is always set to “User,” so 
that you can easily find your custom samples on the instrument. This lets you set the second Category.

Notes
Use this for reference when working in Sample Builder, or in the Editor. Notes are not shown on the instrument.
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Key Zone
Multisamples can have up to 128 Key Zones, one per note. Key Zones cannot overlap.

Graphical editing of Key Zones
Moving an entire Key Zone
To move the entire Key Zone to a different part of the keyboard:
1. Hover the cursor over the middle of the Key Zone’s colored rectangle.
An outline will appear all around the rectangle.
2. Click on the rectangle and drag to the new location.

Changing the Bottom Key or Top Key
To edit the Key Zone’s Bottom Key or Top Key:
1. Hover the cursor over the upper or lower edge of the Key Zone’s colored rectangle.
A thick vertical bar will appear at the edge of the rectangle.
2. Drag the bar to move the edge of the Key Zone.
Tip: when adjusting the boundary between two adjacent Key Zones, drag the edge of the Key Zone you’d like to make 
longer into the Key Zone you’d like to make shorter. 

Changing the Original Key
To edit the Original Key for the current Key Zone:
1. Hold Option (MacOS) or Alt (Windows), and click a note on the virtual keyboard.

Parameters
Color
Colors are automatically assigned to Key Zones. If you like, you can also use this color-picker to set the color manually. 
Colors are used purely to assist in visualization of the Multisample within Sample Builder; they are saved with the 
Multisample file, but are not sent to the instrument.

Bottom Key
[C-1…G9]
This sets the bottom of the Key Zone. It cannot be higher than the Top Key.  
Key Zones cannot overlap, but you can leave blank spaces between them.

Top Key
[C-1…G9]
This sets the top of the Key Zone. It cannot be lower than the Bottom Key.

Original Key
[C-1…G9]
This is the note at which the sample will play at its original pitch. This can be any note, even beyond the Bottom or Top 
Keys if desired.

Fixed Pitch
[Off, On]
Off: The sample will transpose as you play up and down the keyboard. This is the default.
On: All notes in the Key Zone will play the sample as it sounds in the .wav or AIFF file, without transposition. Tune and 
Loop Tune still apply, however. Original Key will be grayed out. This can be useful for drums or special effects. 

Left/Right Level Link (lock icon)

[Off, On]
This links the settings of the Left and Right Level sliders together.
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Left Level
[-100.0…+100.0]
This adjusts the relative volume of the left channel, or of both channels when Left/Right Level Link is On. You can use 
this to make a set of samples play more evenly across the keyboard, when required–or more rarely, to adjust the stereo 
balance of individual samples. Double-click to reset to 0.0.

Right Level
[-100.0…+100.0]
This adjusts the relative volume of the right channel, or of both channels when Left/Right Level Link is On. 

Tune (cents)
[-99.9…+99.9]
This sets the fine tuning of the sample, with a resolution of 1/10th of a cent (1/1,000 of a semitone). Double-click to 
reset to 0.0.

Sample
Horizontal and vertical zoom sliders
At the top right of the Sample window is a horizontal slider, which zooms in and out on the waveform in time (the 
horizontal axis). Similarly, at the bottom right is a vertical slider, which zooms in and out in amplitude (the vertical 
axis). These affect only the view of the waveform, and don’t alter the audio in any way. Double-click either slider to reset 
its zoom level.

One Shot
[Off, On]
Off: the sample play from the Start point, and then loop between the Loop Start and End points.
On: The sample will play once, from the Start point to the End point. Loop Start and Loop Tune will be grayed out.

Boost 12dB
[Off, On]
This doesn’t affect the sample data itself; instead, it causes the instrument to play the sample 12dB louder. Generally 
speaking, if the sample is played polyphonically, leave this turned Off. If it is a drum loop, background vocals etc., turn 
it On.

Loop Tune (cents)
[-99.9…+99.9]
This lets you fine-tune the loop separately from the rest of the sample, with a resolution of 1/10th of a cent (1/1,000 of a 
semitone). Double-click to reset to 0.0.
If One Shot is On, the sample does not loop–so this is grayed out.

Offsets
Start
[Sample Address]
This sets the address at which the sample will start to play. Data before the Start will not be sent to the instrument, and 
will not contribute to the Storage Size.

Loop Start
[Sample Address]
This sets the start of the loop.
If One Shot is On, this is grayed out.
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End
[Sample Address]
If One Shot is Off, this sets the end of the loop. Samples cannot play past the end of the loop. Loop Start and End must 
be at least 8 samples apart.
If One Shot is On, this sets the point at which the sample will stop playing. Start and End must be at least 8 samples 
apart.
Data after the End will not be sent to the instrument, and will not contribute to the Storage Size.

Editing in the waveform graphic
The Sample’s Start, Loop Start, and End are shown by colored vertical lines. Start is green, Loop Start is orange, and End 
is red. To edit these:
1. Hover the cursor over the colored line.
The line will become thicker.
2. Click on the line and drag to the new location.

Contextual Menu
Bring up the Contextual Menu by right-clicking or control-clicking on the Sample or the Key Zone’s colored rectangle. 
The menu contains three commands, as described below. These duplicate the functionality of the similarly-named 
commands in the File and Edit menus.

Reload Selected Sample
This re-loads the current Sample from the .wav or AIFF file, and updates any changes to the loop points and overall 
length. Other metadata is not affected. Use this if you’ve edited a Sample in an external editor. 

Delete Selected Key Zone
This removes the selected Key Zone from the Multisample. You can also do this by pressing the Delete key.

Show Sample In Finder (MacOS) or File Explorer (Windows)
This opens a file-system window to show the location of the current Sample’s .wav or AIFF file.
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Bank window

Bank
Name
This appears as the Collection name on the hardware instrument or plug-in. The length of the name is limited to 24 
characters, so that it fits on the hardware display.

Author
Your name here! You can use the Default Author preference to fill this in automatically; see “Default Author” on page 
14.

Notes
Use this to store notes for reference when working in Sample Builder. Notes are not shown on the instrument.

(Connected device)
This shows the hardware instrument, if any, currently connected to Sample Builder, if any.  Use the Devices menu to 
view and select instruments.

Bank RAM Size
This is the amount of RAM used by all of the Multisamples in the Bank. 
Typically, each Key Zone in a Multisample uses a fixed amount of RAM, unrelated to storage size. Mono Key Zones 
normally use 16 KB of RAM, and stereo Key Zones normally use 32 KB. Very short samples are the exception. If the 
Key Zones are shorter than 8,192 samples from the Start to End offsets–about 1/6 of a second at 48kHz–they’ll use 
their actual length in RAM, which will be smaller than the normal amounts. 
A Bank can use up to 50 MB of RAM, which normally translates to slightly more than 3,000 mono Key Zones, or 1,500 
stereo Key Zones. If the Key Zones are very short, as described above, you’ll be able to fit in more of them.
If the Bank Ram Size exceeds the RAM available on the instrument, this will be shown in red, and you won’t be able to 
send the Bank to the instrument. To resolve this, reduce the size by removing Multisamples.
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Bank Storage Size
This is the amount of storage space used by all of the Multisamples in the Bank, corresponding to the total length from 
Start Offset to End Offset for all of the Multisamples’ Key Zones.
The maximum usable Bank size will vary depending both on the instrument being used and on the size of other data 
stored on the instrument. From the factory, for instance, the wavestate has about 4 GB of available storage space. On the 
instrument, the System Stats page Available Storage parameter shows the actual amount of space available. 
If the Bank Storage Size exceeds the storage space available on the instrument, this will be shown in red, and you won’t 
be able to send the Bank to the instrument. To resolve this, reduce the size by removing Multisamples.

SEND BANK
Pressing this button first removes any user Multisamples from the selected hardware instrument, and then sends 
the current Bank, along with all of its Multisamples and Samples. This is the same as using the Send Bank To Device 
command in the Devices menu.
For plug-ins, use the File Menu Save Bank For Plug-in command instead.

List of Multisamples
The Multisamples in the Bank are shown in this list. All values in the list are read-only. To edit the Multisample’s name, 
Category, or other contents, double-click to open it in the Multisample window. You can also use the Edit Selected 
Multisample command in either the Edit menu or the contextual menu.
To remove Multisamples from the Bank, use the Remove Multisample command in either the Edit menu or the 
contextual menu. This only affects the Bank; the Multisample file on disk remains untouched.
You can drag the columns (Name, Author, Category, etc.) to rearrange them as desired.

Columns
Name, Author, Category, Notes
These are the parameters from the Multisample window.

# Zones
This shows the number of Key Zones in the Multisample.

RAM Size
This is the amount of RAM used by the Multisample. For details on how the number of Key Zones and RAM Size 
interact, see “Bank RAM Size” on page 11.  

Storage Size
This is the amount of storage space used by the Multisample, up to a maximum of 4 GB. (Yes, you can use the entire 
storage space of the wavestate for a single Multisample, if you wish!) The Storage Size corresponds to the total length 
from Start Offset to End Offset for all of the Key Zones in the Multisample. 

Contextual Menu
Bring up the Contextual Menu by right-clicking or control-clicking on the Multisample in the list. The menu contains 
three commands, as described below. These duplicate the functionality of the similarly-named commands in the File 
and Edit menus.

Edit Selected Multisample
This switches to the Multisample window to edit the selected Multisample. You can also do this by double-clicking the 
Multisample in the Bank.

Remove Selected Multisample
This removes the selected Multisample from the Bank. You can also do this by pressing the Delete key. This does not 
affect the Multisample file on disk.

Show Multisample In Finder (MacOS) or File Explorer (Windows)
This opens a file-system window to show the location of the current Multisample file.
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Menus

Preferences
Audio/MIDI
Sample Builder includes a simple built-in 8-voice sample playback engine, so that you can listen to Multisamples as you 
make edits. Note that the sustain pedal is not supported.

Output
This lets you select one of your computer’s audio output devices.

Test
This plays a test tone, allowing you to check whether the audio output device is working.

Sample rate
This sets the sample rate for the audio output device. The available options depend on the device.

Audio buffer size
This sets the buffer size for the audio output. For lower latency, use smaller settings. If this is set too low, however, you 
may hear glitches. The most effective setting will depend on your computer, audio device, and other factors.

Active MIDI inputs
This selects the MIDI input(s) from which to play the Multisamples.

Bluetooth MIDI
This opens the system’s Bluetooth configuration, in order to select Bluetooth MIDI devices for input.

Settings
Check for new versions at startup
When this is enabled, the software checks at startup to see if a new version is available. If so, a dialog appears with a 
download link.

Save Multisample automatically adds to Bank
When this is enabled, saving a Multisample will automatically add it to the current Bank. Note that you’ll still need to 
send the Bank to hear the results on the instrument.

Use file name instead of embedded audio file metadata for sample Original Key detection
This controls how automated keyboard mapping works, both when dragging .wav or AIFF files onto the keyboard, and 
when using the Auto Map Key Zones menu command. 
If this is disabled (un-checked), Sample Builder will first try to use the Original Key (aka “root key”) stored in the 
.wav or AIFF file metadata, usually created by a sample editing application. Not all .wav or AIFF files will have this 
information, however. If Sample Builder sees that the Original Key is not stored in the file, it will look at the file name 
instead, as described under “Preparing your .wav or AIFF samples” on page 2.
If this is enabled, Sample Builder will ignore any data stored in the audio file metadata, and only use the note number at 
the end of the file name. Use this if files have problematic metadata, or if you’d simply like to override the metadata with 
whatever you’ve set up in the names. 
When dragging audio files onto the keyboard, you can swap this behavior by holding down the command key (on 
MacOS) or the Windows key (on Windows). The Command key does not affect the Auto Map Key Zones menu 
command.

Require command key to select zone when playing keyboard (MacOS) 
Require Windows key to select zone when playing keyboard (Windows)
If this is disabled (un-checked), playing on the keyboard will automatically change to the Key Zone which corresponds 
to the played note.
If this is enabled, playing on the keyboard will not normally change Key Zones, unless you hold the command or 
Windows key while playing.
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Default Author
This auto-fills the Author field when a New Multisample or Bank is created (including at startup).

Temp Bank creation folder
This folder is used when preparing a Bank to send to the instrument. Up to 4 GB may be required, temporarily; if there 
isn’t enough space for the current Bank on the selected volume, Sample Builder will show an error message when you 
try to send the Bank.

File
Multisample window only
The following menu commands are available only when the Multisample window is active.

New Multisample
This  creates a new, blank Multisample.

Open Multisample…
This brings up a standard file menu to open a Multisample file from the computer’s drive. Although Banks can reference 
many Multisamples, only one Multisample can be open for editing at a time. 
You can also open a Multisample by double-clicking on it in the Bank window, or by dragging it from the file system 
into the Multisample window.

Save Multisample…
This saves the current Multisample without changing its UUID. If it’s been saved previously, the current name and file 
location are used automatically. If not, a standard file menu will appear to set the file name and location.
Use Save when you’re editing an existing Multisample, and you want the changes to be reflected everywhere that it’s 
used.

Important: It’s critical to understand how UUIDs relate to Multisamples, and how the Save and Save As… 
commands differ in this regard. For details, see “Multisamples are identified by UUIDs” on page 6.
Important: Multisamples do not include the audio data of their Samples; instead, they just link to the separate 
.wav or AIFF files on disk. When moving or backing up data, make sure to include the .wav or AIFF files as 
well as the Multisample files! To make this easier, store the .wav or AIFF files within the same folder structure 
as the Multisample. 

Save Multisample As…
This saves the current Multisample with a new UUID, and lets you change the name and file location as desired.
Use Save As… when you want to make a new, different version of a Multisample–one that won’t change previously 
created sounds.

Import Audio File(s)…
This brings up a standard file menu to import one or more .wav or AIFF files from the computer’s drive. The imported 
files are added to the current Multisample. You can also import audio files by dragging them onto the Multisample 
window’s keyboard.

Reload Selected Sample
This re-loads the current Sample from disk, and updates any changes to the loop points and overall length. Other 
metadata is not affected. Use this if you’ve edited a Sample in an external editor.

Reload All Samples
This re-loads all of the Samples in the current Multisample, as described under Reload Selected Sample above. 

Bank window only
The following menu commands are available only when the Bank window is active.

New Bank
This  creates a new, blank Bank.



Menus

15

Open Bank…
This brings up a standard file dialog to open a Bank file from the computer’s drive. Note that only one Bank can be 
loaded at a time.

Save Bank…
This saves the current Bank. If it’s been saved previously, the current name and file location are used automatically. If 
not, a standard file menu will appear to set the file name and location.

Save Bank As…
This brings up a standard file dialog, so that you can save the Bank with a new name or in a different location.

Save Bank For Plug-in…
This brings up a standard file dialog to save a self-contained version of the Bank and all of its Multisamples and 
Samples, for use by compatible plug-ins. Since the file contains all of the sample data, it can be quite large - up to 4 GB. 
The file extension is .korgcompiledbank.

Important: .korgcompiledbank files are only for use to export Sample Builder data to compatible plug-ins. 
Once saved, they cannot be opened or edited by Sample Builder. Make sure to preserve your original Bank, 
Multisample, and .wav or AIFF sample files.

Consolidate Bank Files…
This creates duplicate copies of all of the Bank’s .wav and AIFF files and Multisample files, and places them in a new 
folder hierarchy. A standard file dialog appears, to select the new location on disk. The original files are not changed or 
moved.

Add Multisample(s)…
This brings up a standard file dialog to add one or more Multisample files to the Bank. 

Important: Banks do not include the audio data of their Samples, nor the key mapping and other information 
in their Multisamples; instead, they just link to the separate .wav, AIFF, and Multisample files. When moving 
or backing up data, make sure to include the .wav and Multisample files, as well as the Bank file!

Import Audio Files As Multisamples…
This brings up a standard file dialog to select wav or AIFF files. Once you’ve select the files , Sample Builder creates 
a separate Multisample for each imported audio file. You can also invoke this by dragging audio files into the Bank 
window (as opposed to the Multisample window).

Both Multisample and Bank windows
The Show In Finder/File Explorer command is always available, but its function changes depending on which window 
is active.

Show Sample/Multisample In Finder (MacOS) or File Explorer (Windows)
When the Multisample window is active, this opens a file-system window to show the current Sample’s .wav or AIFF 
file.
When the Bank window is active, this opens a file-system window to show the current Multisample’s file on disk.

Edit
Multisample/Bank [edit action] Undo
Undo/redo buffers are maintained separately for the Multisample and Bank windows, and the menu command is 
prefixed by the current mode as a reminder of this. The specific action to undo is also included in the menu command; 
for example, Multisample Undo: Change Top Key. 

Multisample/Bank [edit action] Redo
Undo/redo buffers are maintained separately for the Multisample and Bank windows, and the menu command is 
prefixed by the current mode as a reminder of this. The specific action to redo is also included in the menu command. 

Edit Selected Multisample
This command is available in the Bank window; it switches to the Multisample window to edit the selected 
Multisample. You can also do this by double-clicking the Multisample in the Bank.
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Remove Selected Multisample
This command is available in the Bank window; it removes the selected Multisample from the Bank. This does not 
affect the Multisample file on disk.

Delete Selected Key Zone
This command is available in the Multisample window; it removes the selected Key Zone from the Multisample. This 
does not affect the .wav or AIFF file on disk.

Auto Map Key Zones
This command will reset the Original Keys for all Key Zones in the Multisample, using either metadata from the .wav 
or AIFF file or the file name, as described under “Use file name instead of embedded audio file metadata for sample 
Original Key detection” on page 13. Keyboard zones are also set automatically, based on the original keys.

Devices
[List of available target instruments]
This shows all of the connected hardware instruments which are available to receive data from Sample Builder. If there 
are more than one of these, select the one that you’d like to work with.

Send Bank To Device
This first removes any user Multisamples from the selected instrument (to free up space), and then sends the current 
Bank, along with all of its Multisamples and Samples. This is the same as pressing the SEND BANK button.

Remove Bank On Device
If there are user Multisamples on the selected instrument, this command removes them. Any Programs or Wave 
Sequences which referred to the removed Multisamples will remain, but will play silence instead of the removed 
Multisamples.

View
Show Multisample (command-1)
This makes the Multisample window active.

Show Bank (command-2)
This makes the Bank window active.

Zoom 50%…150%
This changes the zoom level of the Sample Builder as a whole. Use this to make the window smaller, to better fit onto 
laptop screens, or larger, to take advantage of larger displays.

Help
Search field (MacOS only)
This brings up the standard search menu for system help, including the application’s menu commands.

About Sample Builder (Windows only)
This displays the Sample Builder software version.

Check for Updates…
This  checks to see if a new version is available. If so, a dialog appears with a download link. You can also configure the 
software to check for updates automatically; see “Check for new versions at startup” on page 13.

Open Online Manual
This opens the latest version of the pdf manual in your browser.
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